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1 – Overview 

1.1 – What is Kaleidoscope Kreator?  

Very simply, Kaleidoscope Kreator creates photo kaleidoscopes from digital images. It allows you 
to view your entire photo while choosing exactly what portion of your image will be used to create 
the kaleidoscope. This makes it ideal for creating kaleidoscopes of people or other distinct 
subjects to be used in both traditional and digital scrapbooking, card making, quilting and many 
other craft projects. 

Workspace: 

 
 

Preview: 
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1.2 – Creative Uses for Kaleidoscope Kreator 

Kaleidoscope Kreator was designed with scrapbooking in mind, but there are many other uses for 
photo kaleidoscopes, including card making and quilting. Kaleidoscopes can be made from any 
image in digital format including photos and artwork. (Digital images can be obtained from 
scanners or digital cameras or created using other graphics/painting computer applications.) 

Scrapbooking 

 

Traditional scrapbooking: A simple star 
kaleidoscope was printed from Kaleidoscope 
Kreator, then cut out and mounted on cardstock. A 
photo was then glued in the center and die-cut 
letters and stars were added to complete the page. 

Shape: Star 

Pinwheel Mode: Off 

   

 

Traditional/digital scrapbooking: This page 
layout was created from two different 
kaleidoscopes. The first kaleidoscope is easily 
recognized as the star shape of a baby boy in his 
carrier seat. The second kaleidoscope is found in 
the background paper! A small 2" square 
kaleidoscope was created from the same photo 
using just the booties on the feet. The small 
kaleidoscope was then brought into another image 
editing program and duplicated many times (4 
across and 4 down) to create a patterned paper 
background. The patterned background was 
printed out separately from the larger kaleidoscope 
and they were then combined using traditional 
scrapbooking techniques. 

Shape: Star and Square 

Pinwheel Mode: Off 
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Digital scrapbooking: This kaleidoscope was 
created using Kaleidoscope Kreator and saved to a 
file. The file was then opened in another image 
editing program to complete the digital layout. A 
photo was added to the center and two smaller 
photos were added outside the kaleidoscope. 
Borders were added around each element and 
journaling was added to complete the page. 

Shape: Scallop 

Pinwheel Mode: Off 

 

Scrapbooking Embellishments 

 

Kaleidoscopes to match your photos: The 
corner embellishments in this layout are pinwheels 
that were created from the photo in the center 
(using only the section containing the baby birds.) 

Shape: Pinwheel 

Pinwheel Mode: On 

   

 

Kaleidoscopes in many different shapes: Don't 
limit yourself to just circular or square 
kaleidoscopes. The green strips and the die-cut 
"ZOO" letters in this layout are all created from one 
small kaleidoscope. The kaleidoscope was created 
using the greenery in the background of the main 
photo, then saved to a file. The file was then 
brought into an image editing program and 
duplicated many times to create a patterned paper 
effect. The "patterned paper" design was then 
printed and cut to create the long strips and letters 
in the layout. 

Shape: Square 

Pinwheel Mode: Off 
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Cards & Other Paper Crafts 

 

Kaleidoscope cards: There is nothing quite as 
simple yet so elegant as kaleidoscope cards. 
Simply print a kaleidoscope from Kaleidoscope 
Kreator and cut it out, then attach to cardstock for a 
beautiful card! (This card was created using five 
printed kaleidoscopes, each slightly smaller than 
the other, stacked on top of one another.) 

Shape: Lotus 

Pinwheel Mode: On 

   

 

Oh, the possibilities! Whether used for cards or 
other paper crafts, the possibilities for 
Kaleidoscope Kreator are limited only by your 
imagination! Here we created a Flower shape 
kaleidoscope from a photo of roses. We printed the 
kaleidoscope in a few different sizes, then cut them 
out and inked the edges. Finally we arranged them 
with some leaves for something completely 
different! 

Shape: Flower 

Pinwheel Mode: Off 

 

Quilting 

 

Quilting: Now that there are a wide variety of 
colorfast fabrics available for inkjet printing, the 
creative possibilities for quilting have increased 
dramatically. Special memory "photo quilts" are 
now popular. Imagine a kaleidoscope as the center 
piece of a photo star quilt! 

Shape: Star Quilt 

Pinwheel Mode: Off 
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2 – Quick Start Guide – Four Simple Steps! 

2.1 – Step 1: Open Image 

Click on the Open Image button and use the file browser to open an image: 

 

After you click on the button, you will see the standard Windows® Open dialog box: 
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After opening a file, the workspace should look something like this: 

 

 

2.2 – Step 2: Position Image 

Using your mouse, you can position your image within the template shape. The mouse action 
changes as you position the mouse over or next to the image. The shape of the mouse pointer 
changes to indicate which action will occur when you click the mouse button. 

To resize the image, move the mouse over the corners, then click and drag. 

To rotate the image, click and drag the mouse outside the image boundary.  

To move the image around the work area, position the mouse over the image, then click and 
drag. 

The goal is to position the image such that the part you want to use for the kaleidoscope is inside 
the wedge-shaped template in the work area. 

In the example on the next page, the image has been reduced in size slightly and rotated to the 
left so that the subject’s foot is centered in the tip of the wedge and the hands are just touching 
the edges: 
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2.3 – Step 3: Preview Kaleidoscope 

Click on the Preview button to see what your kaleidoscope will look like.  
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To continue, click OK to close the Preview window. 

 

 

2.4 – Step 4: Print or Save 

Print your kaleidoscope directly from Kaleidoscope Kreator using the Print Kaleidoscope button 
or save it to a file using the Save Kaleidoscope button to edit in another program or print later.  
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Kaleidoscope Kreator will ask you to specify the size before saving or printing. The default size is 
6 inches at 300dpi resolution. You can change this or just click OK for now. 
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3 – Detailed Users Guide 

3.1 – Workspace Description 

The Kaleidoscope Kreator workspace is divided into the following areas: 

 

A. Staging Area 

The staging area is where all of the “action” takes place. This is 
the area where you arrange your photo so that the subject is 
inside the mask. 

B. Shape Selection 

The drop-down menu is where you to choose the shape of your 
kaleidoscope. 

C. Preview Area 

The Preview Area contains a small thumbnail of the 
kaleidoscope that is constantly updated as the photo is adjusted 
in the staging area. Clicking on the Preview button will generate 
a full-screen size version of the kaleidoscope. 
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D. Pinwheel Mode 

Pinwheel Mode turns off the "mirroring" that occurs in normal 
kaleidoscopes. It can be used with any shape. 

E. Flip Image 

These two buttons allow you to flip the photo horizontally or 
vertically. 

F. File Operations 

These buttons control the file operations: 
a. Opening an image 
b. Saving a kaleidoscope to a file 
c. Printing a kaleidoscope 

 

3.2 – Open Image 

To open an image, either use the menu selection File > Open Image… or click on the Open 
Image button. 

 

Use the standard Windows Open dialog box to browse for the file you want to open; 
Kaleidoscope Kreator will remember the last directory that you opened. Kaleidoscope Kreator 
supports BMP, JPEG, PNG and non-compressed TIFF files; files in other formats will result in an 
error if you attempt to open them. (See Supported Image File Types in the Appendix for more 
information on file types.) 
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If you do not see all of your images on your hard drive, it is possible that you are viewing files of 
just one file type. In this case, choose "All files" to see all of your files. 

As soon as an image is loaded, the Preview Thumbnail becomes active. The Preview Thumbnail 
is updated whenever the image is moved within the workspace, the image is flipped or the 
pinwheel mode is changed. 
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3.3 – Choose a Shape 

Once an image is loaded, select the shape you want for your kaleidoscope. You can choose from 
one of twelve shapes: 

 
Scallop 

 
Flower 

 
Lotus 

 
Lace 

 
Star 

 
Northern Star 

 
Star Quilt 

 
Pinwheel 

 
Celtic Cross 

 
Sunburst 

 
Circle 

 
Square 

The shape is chosen from the Edit menu or the drop-down menu in the upper right portion of 
the application window. 
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The Square and Celtic Cross shapes are a bit of a special case and the templates may be 
confusing at first glance. The image below shows an overlay of the Square shape so that you can 
see how the template wedge fits into the square: 
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3.4 – Position the Image 

There are a number of ways you can position your image within the workspace staging area. The 
goal is to position the image such that the part you want to use for the kaleidoscope is inside the 
wedge-shaped template in the staging area.  

Important Note: If the image is positioned such that it does not fill the entire template, the empty 
portion will be filled with white in the resulting kaleidoscope. 

Using the mouse 

The mouse action changes as you position the mouse over or next to the image. 
The shape of the mouse pointer changes to indicate which action will occur when 
you click the mouse button. 

To resize the image, move the mouse over any corner, then click and drag. 
Dragging any of the four corners has the same effect; the image is resized from 
the center point. 
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To rotate the image, click and drag the mouse pointer outside the image 
boundary. 

 

 

To move the image around the workspace staging area, move the mouse 
pointer over the image, then click and drag. 
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Using the keyboard 

The following keystrokes will allow you to fine-tune the positioning of your image 
within the wedge-shaped template: 

Resizing 

+ : increases the size of the image by 0.5% 

 - : decreases the size of the image by 0.5% 

Rotating 

/ : rotates the image counter-clockwise by 1 degree 

* : rotates the image clockwise by 1 degree 

Repositioning - The following numbers correspond to the arrow keys on the 
NumPad of most keyboards. (Make sure that NumLock is ON.) 

2 : moves the image down by 5 pixels 

4 : moves the image left by 5 pixels 

6 : moves the image right by 5 pixels 

8 : moves the image up by 5 pixels 

3.5 – Using the Flip Image buttons 

The Flip Image buttons are used to "flip" the image in the workspace. 
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The Flip Image Vertically button flips the image upside down: 

 

 

The Flip Image Horizontally button flips the image left & right: 
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Be aware that the Flip Image buttons flip the image with respect to the original orientation of the 
image (i.e. flip axes rotate and move with the positioning of the photo.) The following example 
shows how the image appeared after it was opened with dashed-line showing the Horizontal Flip 
axis: 

 

After being rotated nearly 90 degrees, the image in the workspace staging area appears as 
below. Notice the location of the Horizontal Flip axis: 
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Now pressing the Flip Image Horizontally button flips along the Horizontal Flip axis, as shown 
below: 

 

 

3.6 – Pinwheel Mode 

Pinwheel Mode turns off the mirroring effect that creates kaleidoscopic images. It is turned on by 
checking the box next to the pinwheel icon. The thumbnail preview updates as Pinwheel Mode is 
turned on and off.  
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Pinwheel Mode can be used with any template shape, though some shapes work better than 
others. (As you might guess, the Pinwheel Shape works best with Pinwheel Mode turned on.)  

The following two examples show the effect of Pinwheel Mode. The position of the photo in the 
template is exactly the same in both instances; only the Pinwheel Mode has been changed. 

Kaleidoscope: 
Because of the mirroring effect of kaleidoscopes, it looks like the little boy on the 
bicycle is running into himself. 

 

 

Pinwheel: 
With Pinwheel Mode turned on, the little boy now looks like he is riding around in 
a circle. 
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"Texture photos", i.e. photos with no clear subject, can result in some particularly beautiful 
pinwheels: 

Kaleidoscope: 

 

Pinwheel: 

 
 
 

3.7 – Preview Kaleidoscope 

Use the Preview to verify that you have positioned the image to your liking. Choose View > 
Preview from the menu or click on the Preview button to see what your kaleidoscope will look 
like. Click the OK button to close the Preview window and continue.  

Note: The quality of the Preview is lower than the quality of a saved or printed kaleidoscope. This 
is normal and helps to decrease the time that it takes to render the kaleidoscope preview. 

Important: The Preview does not save the kaleidoscope in any way. If you close the Preview 
window and then move the image in the workspace staging area, the kaleidoscope you 
previewed is lost. If you want to keep the kaleidoscope you see in the Preview, you must first 
save the kaleidoscope to a file before you reposition the image in the workspace. 
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3.8 – Set Kaleidoscope Size 

Before you print or save a kaleidoscope, you are prompted to set the size. If you don’t set the 
size, the default size of 6 inches and 300 dpi will be used. To set the kaleidoscope size, choose 
Edit > Kaleidoscope Size… from the menu. 

Important Note for Windows® 98 and Windows® Me users: 

Due to operating system limitations, Windows® 98 and Windows® Me users are limited to a size 
of 2300 pixels (or 7.67" at 300dpi.) However, you can achieve a larger print size by lowering the 
resolution of the image. 

 

If you check “Always show this dialog before printing 
and saving”, you will see this dialog whenever you 
choose to print or save a kaleidoscope. Unless you 
always print or save the same sizes, it is recommended 
that you keep this box checked so that you don't have 
any surprises after saving or printing a kaleidoscope. (It 
is very easy to forget to set the size manually before 
you print or save a kaleidoscope.) 

The Pixel Dimensions are most useful if your 
kaleidoscope is destined for the web or email. Images 
displayed on-screen are sized in pixels. 

If you plan to print your kaleidoscope or save it for use 
in a design that is measured in inches or centimeters, 
you will want to set the Print Size.  

 

Pixel Dimensions and Print Size are interrelated and changing one will adjust the other.  
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If you want to change the Resolution and Print Size, change the Resolution first as it will always 
update the Print Size (keeping the Pixel Dimensions constant.) 

For a more detailed discussion on Pixel Dimensions and Print Size, see Understanding Image 
Size in the Appendix. 

3.9 – Print Kaleidoscope 

You can print your kaleidoscope directly from Kaleidoscope Kreator by either choosing the File 
> Print… menu item or clicking on the Print Kaleidoscope button.  

 

If the “Always show this dialog before printing and saving” option in the Kaleidoscope Size dialog 
box is checked, then you will first be prompted to set the kaleidoscope size. You will then be 
presented with the standard Windows® Print dialog box. Once you click OK to print, Kaleidoscope 
Kreator will generate the kaleidoscope at the specified size and send it to the printer.  

Note: Kaleidoscope Kreator does not save the kaleidoscope it generates for the printer; instead, 
it generates a new kaleidoscope each time the print function is selected. Thus, if you want 
multiple copies of the same kaleidoscope, either set the number of copies to print in the print 
dialog box or save the kaleidoscope to a file for printing at a later time using another image 
editing software program. If you want to both print and save the file, it is recommended that you 
save the kaleidoscope to a file first, then print that file from another program to reduce the amount 
of time spent rendering kaleidoscopes. 

3.10 – Save Kaleidoscope 

You can save your kaleidoscope to a file by either choosing the File > Save… menu item or 
clicking on the Save Kaleidoscope… button.  
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If the “Always show this dialog before printing and saving” option in the Kaleidoscope Size dialog 
box is checked, then you will first be prompted to set the kaleidoscope size. You will then be 
presented with the standard Windows® Save As dialog box. Once you click OK to save, 
Kaleidoscope Kreator will generate the kaleidoscope at the specified size and save it to the 
specified file.  

IMPORTANT: If you want to save two kaleidoscopes to the same file name but different file 
formats, you will need to retype the name rather than click on the name of the first file that you 
save and then changing the format. Doing the latter will cause the original file to be overwritten 
with the new file format. Instead choose the file type first, then retype the name.  

Note: If you want to both print and save your kaleidoscope, it is recommended that you save the 
kaleidoscope to a file first, then print that file from another program to reduce the amount of time 
spent rendering kaleidoscopes. If at a later time you wish to print a saved kaleidoscope, you must 
use an image editing program other than Kaleidoscope Kreator. 
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4 – Appendix 

4.1 – System Requirements 

Minimum system requirements: 

Windows® 98SE*, Me*, 2000 or XP 
128 MB of RAM  

35 MB of available hard disk space 

*Limited support for Windows® 98SE & Me due to operating system limitations. 
Kaleidoscope sizes are limited to 2300 pixels. (That is just under 8” at 300dpi, but 
lowering the resolution will allow for larger print sizes. See Understanding Image 
Size in the Appendix for more information.) 

Recommended system requirements: 

Windows® 2000 or XP 

256 MB RAM or more 

35 MB of available hard disk space 

Windows® is a registered trademark of Microsoft Corporation. 

 

4.2 – Supported Image File Types 

BMP - Windows Bitmap (.bmp) format is an historic file format that is still widely used. It was 
developed by Microsoft® as a device-independent bitmap format, i.e. the image data is stored in 
such a way that the image can be displayed by Windows® on any type of display device. In 
general, it is not the preferred format to store images because it is not supported on other 
platforms such as Mac®. 

JPG (or JPEG) – The Joint Photographic Experts Group (.jpg) format is optimized for photos and 
other “continuous tone” images. That is why it is the format of choice for most digital cameras. Its 
compression scheme analyzes an image and “discards” those pixels which the human eye most 
likely won’t notice. However, because it “discards” information, it is a lossy file format and if the 
compression is too strongly applied, you will see the effects of it! ("Lossy" simply means that 
some image data is "lost" in the compression process.) That said, huge savings in files sizes can 
be had (over TIF) without much noticeable degradation. It should be noted however that 
repeatedly saving the same file in JPG format will cause a cumulative loss of data which can very 
quickly become noticeable to the naked eye. If you need to edit a file, it is best to save the 
intermediate steps as TIF, then save the final version as JPG (if necessary). 

PNG – The Portable Network Graphics (.png) format was developed to replace the GIF format in 
order to improve the severe lossy compression scheme as well as a counter to the proprietary 
licensing that GIF format requires. It uses a lossless compression scheme (i.e., no data is "lost" in 
the compression process) and while it doesn’t reduce file sizes as much as GIF, it completely 
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preserves the original data. It also supports transparency and perhaps because of this is a 
popular format for sharing digital scrapbooking elements.  

TIF (or TIFF) – The Tagged Image File Format (.tif) is a flexible format that can be both 
compressed and non-compressed. The compression (if applied) is lossless, but is not universally 
supported. (Kaleidoscope Kreator is included in the list of those that do not support compressed 
TIF files.) Because of this, files saved in TIF format are often not compressed and thus quite 
large. However, TIF is still the standard choice for archiving images that you want to keep for 
years to come because it is non-proprietary and contains all of the “original” data, including the 
color mode and image size information. 

Windows® and Microsoft® are registered trademarks of Microsoft Corporation. 
Mac® is a registered trademark of Apple Computer, Inc. 
 
 

4.3 – Understanding Image Size 

Image size is composed of three related parts: 

1. Pixel Dimensions 

2. Print Size 

3. Resolution 

1. Pixel Dimensions 

Pixel Dimensions refers to the total number of pixels that make up a digital 
image. ("Pixels" stands for "picture elements", i.e. the elements that make up a 
picture.) Pixel dimensions are referenced in terms of width x height, e.g. 
600x400. The greater the number of pixels, the more information (or detail) an 
image contains. 

2. Print Size 

Print Size is perhaps the easiest component to understand because it is simply 
the dimensions (in inches or centimeters) that an image is printed at. When 
someone refers to a 4"x6" image, they are refering to the print size. 

3. Resolution 

Resolution refers to how much information is contained in a given amount of 
space. Resolution is referenced in terms of dots per inch (or dpi). The important 
thing to remember about resolution is that the higher the resolution, the more 
detail you will see in your printed images.  

To better understand resolution, it may be easier to think of the dots as squares - 
or more specifically as tiles in a mosaic. Imagine that you are remodeling your 
kitchen and you've decided to put a tiled mosaic on the wall behind your stovetop 
in a space of about 3'x3' (about the size of the stovetop itself.) You've drawn the 
outline of a sunflower on the wall to guide the placement of the tile: 
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Now it's time to actually choose the tile for your mosaic. Your goal is to create the 
mosaic with as much detail as possible while minimizing the amount of tile cutting 
you will need to do. When you get to the store, you discover that tile comes in 
many different sizes, e.g. 4", 2", 1" and 1/2" (to name just a few.)  

Imagine trying to create a mosaic of the sunflower using only the 4" tiles. Would 
you recognize the design as a sunflower or just a bunch of different colored 
squares? Now imagine trying to create the mosaic design using the 2" tiles. You 
may be able to recognize the sunflower in the design, but it will probably take 
some imagination. Now imagine creating the entire mosaic using 1" tiles and then 
1/2" tiles. Think of how many tiles that would be!! The following examples provide 
a visual example of the differences using each of the different tile sizes. (Move 
your mouse over each of the images, to see the sunflower sketch superimposed 
on the mosaic.) 

 
Sunflower mosaic using 4" tiles 

 
Sunflower mosaic using 2" tiles 

 
Sunflower mosaic using 1" tiles 

 
Sunflower mosaic using 1/2" tiles 
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Why have we spent all this time explaining mosaic tiles? Because pixels are like 
mosaic tiles! The more pixels you fit into a given space (i.e., the higher the 
resolution), the more detail your printed image contains. 

You may have read or heard advice that images destined for the web or e-mail 
should have a resolution of 72 dpi; likewise images destined to be printed should 
have a resolution of 300 dpi. While these are not hard and fast rules, there is a 
reason these numbers exist. A computer monitor cannot display more than 72 
dots per inch. (Actually, advances in technology has changed this, but that is 
another discussion.) So creating an image with a higher resolution does not 
actually provide more detail for the viewer because the computer monitor cannot 
display more detail than 72 dpi. Printers on the other hand (including inkjet 
printers) can print at least 300 dots per inch (and often more.) That is four times 
more information (i.e. detail) that can be included in an image to be printed than 
one destined for the web: 

 

Why does all of this matter? 

Having a good understanding of the relationship between pixel dimensions, print 
size and resolution will give you greater control over the quality of your images: 
Pixel Dimension = Print Size * Resolution. A resolution that is too low may result 
in your printed images looking pixelated, i.e. you can see the individual pixels. A 
resolution that is too high (thus resulting in a larger number of total pixels) will 
increase the processing time on an image because more pixels have to be 
processed than are really necessary. 

 

Examples 

Let's take a look at some examples to visually see how this all fits together. In 
each of the examples below, the size of the image is shown relative to a "printed" 
6"x4" grid. 
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Example 1 - We start with an image of 300x225 pixels at 72dpi. If we increase 
the resolution while keeping the pixel dimensions the same, the print size will 
decrease. It is important to note that because the pixel dimensions remained the 
same and the resolution increased, the perceived quality of the image stays the 
same (or may look better), though the printed image size will be smaller. 

At 72dpi, the print size is 
4.17"x3.13": 

Print size = Pixels / resolution 

Print size = 300 px/ 72 dpi= 4.17" 

Print size = 225 px / 72 dpi= 3.13" 

 
 
   

Increasing the resolution without 
changing the pixel dimensions 
results in a decrease in the print 
size. 

Print size = Pixels / resolution 

Print size = 300 px / 150 dpi = 2" 

Print size = 225 px / 150 dpi = 1.5" 
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Example 2 - We start with an image of 900x675 pixels that prints at 3"x2.25". If 
we increase the print size while keeping the pixel dimensions the same, the 
resolution will decrease. It is important to note that when the pixel dimensions 
stay the same and the resolution decreases, the quality of the image may 
degrade because the same number of pixels are spread out over a larger area 
which has the effect of increasing the size of the pixels. If the change is large 
enough, you may see some pixelation of your image when printed. 

At 3"x2.25", the resolution is 300 dpi: 

Resolution = Pixels / print size 

Resolution = 900 px / 3" = 300 dpi 

Resolution = 675 px / 2.25" = 300 dpi 

 

 
 

Increasing the print size while keeping 
the pixel dimensions the same results 
in a decrease in resolution. 

Resolution = Pixels / print size 

Resolution = 900 px / 6" = 150 dpi 

Resolution = 675 px / 4.5" = 150 dpi 
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Example 3 - We start with an image that is 3"x2.25" and 300dpi. If we decrease 
the resolution while keeping the print size the same, the pixel dimensions will 
decrease. It should be noted that any time the pixel dimensions are changed, 
there is a decrease in the quality of the image because the graphics application 
must average the correct color values for the remaining pixels. In this case, the 
averaging of the color values in addition to the decreased resolution further 
degrades the image quality. Look closely at the stamens of the flower to see the 
effect of this. 

At 3"x2.25" and 300dpi, the pixel 
dimensions of the image are 
900x675. 

Pixels = Print size * resolution 

Pixels = 3" * 300 dpi = 900 

Pixels = 2.25" * 300 dpi =675 

 
 

Decreasing the resolution while 
keeping the print size the same 
results in a decrease in pixel 
dimensions. 

Pixels = Print size * resolution 

Pixels = 3" * 150 dpi = 450 

Pixels = 2.25" * 150 dpi =338 

   

  

 


